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1. Scope

This document extracts the requirements for the Graphical User Interface (GUI) from the I-15 HOV Reversible Lane Control System Project, System Requirements Document, and organizes them into a top-level design for the user interface.  This document identifies the user type requirements and user security requirements.  This defines several levels of user access capabilities.  The document then identifies all required user tasks, by user type and user security level.  Each identified task creates a need for a user interface design feature to implement the requirement and provide the user with an efficient means of accomplishing the task.

The document then identifies those user interface design features and groups them into categories.  These categories include:

· Map presentations, including icons for representing the type, location, state and status of field devices, such as gates, pop-ups, CCTV cameras, etc.

· Windows for presenting text and graphic information and for presenting menus of user commands and response actions.

Finally, the document identifies a set of general rules for navigating through and between the windows.  These general rules will define a consistent and efficient interface for the various users.

2. Applicable Documents

1. System Requirements Document, Version C, for the I-15 HOV Reversible Lane Control System Project, TransCore, December 4, 1998

2. Designing the User Interface, 3rd Edition, Ben Shneiderman, Addison-Wesley 1998

3. Guidelines for Enterprise-Wide GUI Design, Susan Weinschenk, Sarah C. Yeo, John Wiley, 1995

4. Designing Visual Interfaces, Kevin Mullet, Darrell Sano, Prentice Hall PTR, 1995

3. GUI Requirements

3.1 User / Task Functional Requirements

3.1.1 User Profiles

Users shall be defined by four attributes:

· Which type of workstation they are using

· Their authorized user type as assigned by the system administrator

· Their authorized security level as assigned by the system administrator

· Their authorized control level as assigned by the system administrator

3.1.1.1 Type of Workstation

The system shall support six different locations for user.  Each location shall have different features and capabilities.  For example, video display is only available at the workstations at the TMC and is not available to workstations at the FCU or the DCU.  The system shall support the following six locations:

5. TMC HOV User

6. TMC Maintenance User

7. TMC Trainer

8. FCU Dial-in User

9. FCU User

10. DCU User

Each user type will exist on the simulation system and on the live system.  Commands issued at the simulator workstation will only control the simulator components, not the live field devices.

3.1.1.2 Security Level

The system shall support six levels of security authorization for users.  The system administrator shall assign the security level when a user is registered on the system.  The six levels of security enable the system to accommodate and control the actions of who have a; variety of capabilities and needs.

The six levels of security, in descending order, are:

· System Administrator – highest access privilege, access to Configuration Tasks and all lower security level tasks

· Security Level 1 – access to all command tasks (Command Level 3), initiation and override commands and all lower security level tasks

· Security Level 2 – access to macro command tasks (Command Level 2 and all lower security level tasks

· Security Level 3 – access to super macro command tasks (Command Level 1) and lower security level tasks

· Security Level 4 – no command tasks, only data entry tasks and lower security level tasks

· Security Level 5 – review and print reports viewing system status

3.1.1.3 Command Level

The system shall support three levels of command authority.  Each command levels shall be associated with a security level.  The three command levels are:

· Control Level 1 – super macro command tasks (open / close)

· Control Level 2 – macro command tasks (groups of devices)

· Control Level 3 – individual device command tasks

3.1.2 Task Profiles

The system shall support the following task profiles:

Table 3.1 - Task Profiles by User

	#
	TASK
	USER TYPE
	SECURITY LEVEL
	TASK DETAILS

	1
	Logon
	All
	All
	Operator shall enter user name and password.  After successful login, user name, date and time, and workstation location shall be displayed.

	2
	Accept Command Control
	All except 3
	Level 3 and up
	After successful logon, the user will be asked to accept or deny command control (become the operator) if their configured security level is higher than or equal to the current operator’s

	3
	Transfer Command Control
	All except 3
	Level 3 and up
	Transfer operator status to another logged on user by current operator only

	4
	Zoom-in / zoom-out on map
	All except 3
	All
	Select different scale maps

	5
	Select display of:

Device Status

HOV facility status
	All except 3
	All
	

	6
	Select display of:

Map

Device and device location

Traffic volume

Traffic speed

Incidents

Direction of traffic flow

External interface and status
	All except 3 and 6
	All
	

	7
	Level 1 System Control (super macro control)
	1 only
	Level 3 and up
	Control, by current operator only, to open north or south bound in AM or PM or emergency

	8
	Level 2 Device Group Control (macro level control)
	1, 2, 4, 5
	Level 2 and up
	Control, by current operator only, of:

· pop-ups by location (with location 1 split into an entrance and a wrong-way part)

· gate

· lights by location

· CMSs by highway (NB 15, NB 163, SB 15)

	9
	Level 3 Individual Device Control
	All except 3
	Level 1 and up
	Control, by current operator only, of:

· Pop-up by bank

· Individual CMS

	10
	Device Reset
	All except 3
	Level 3 and up
	Reset of non-responsive device by current operator only

	11
	Command Confirmation
	All except 3
	Level 3 and up
	Confirmation of individual device response to a command by current operator only

	12
	Command Override
	All except 3
	Level 3 and up
	Allows the current operator only to skip a command

	13
	Set Device Status
	All
	Level 3 and up
	Allows a field device or external interface to be manually designated as operable or inoperable

	14
	Set, edit and delete user, user security level, user name and password
	1 only
	System Administrator
	

	15
	Edit User Display Profile
	1 only
	System Administrator
	

	16
	Set Logon Timeout Parameter
	1 only
	System Administrator
	

	17
	Edit Contact List
	1 only
	System Administrator
	

	18
	Edit “Daily Diary”
	All
	Level 4 and up
	

	19
	Create, edit, export and delete Problem Work Orders
	All
	Level 4 and up
	

	20
	Edit Schedule
	All
	Level 4 and up
	

	21
	Page Contacts
	All
	Level 4 and up
	Allows the contact list to be paged because of a Critical Alarm

	22
	Specify and Retrieve Archived Reports
	All except 6
	All
	Retrieve reports from archive media

	23
	Display / Print /Export Report, Daily Diary, Problem Work Order, Schedule and Contact List
	All except 6
	All
	Print capability only at TSU and FCU dial-in workstations

	24
	Display Help Screen
	All
	All
	

	25
	Select Camera Image
	1 and 2
	Level 3 and up
	Allow user to select the video image from a specific camera for display (selection by the operator will override, if necessary, selection by any other user)

	26
	Pan, tilt, and zoom Surveillance Camera
	1 and 2
	Level 3 and up
	Allows a user to point and zoom a surveillance camera unless that camera’s video is selected by the current operator

	27
	Transfer Control of Camera to / from ATMS
	1, 4, 5
	Level 3 and up
	Allows the current operator to transfer control of a camera, or group of cameras, to or from an ATMS Operator

	28
	Configure Field Device
	All except 6
	System Administrator
	Add or delete a field device from the system

	29
	Generate Training Scenarios
	3 only
	Level 3 and up
	

	30
	Select and Execute Training Scenario
	3 only
	Level 3 and up
	

	31
	Enter, edit and delete incident information
	All
	Level 3 and up
	


3.2 User Interface Functional Requirements

3.2.1 System Icons

This section describes required icons and the required functionality of the icons for the I‑15 Reversible Lane Control System.  The specifics of the icons will be defined during the detailed design.

3.2.1.1 Gates

The gates referred to in this section are the entrance blocking gates at both ends of the freeway.

3.2.1.1.1 An icon shall be selected during detailed design to show a gate in a closed position.

3.2.1.1.2 An icon shall be selected during detailed design to show a gate in an open position.

3.2.1.1.3 An icon shall be selected during detailed design to show a gate in a partially open (15%) open position.

3.2.1.1.4 The gate icon shall be configurable to show the name of the gate with the icon.

3.2.1.1.5 The gate icon shall be configurable to show the state of the gate (e.g., open or close).

3.2.1.1.6 The gate icon shall be configurable to show the status of the gate (operational, failed, or no data).  The color of the gate icon shall be changed to show the status of the gate.

3.2.1.1.7 When the operator moves the mouse over a gate icon a text window shall be displayed showing a summary of the gate status.  The details of the summary status display will be defined in the GUI design document.

3.2.1.1.8 The operator shall be able to activate a detailed device status window for the selected gate by double left clicking on the icon.  This action shall cause a circle to be displayed over the gate icon for as long as the detailed device status window is displayed for that gate.

3.2.1.1.9 The operator shall be able to activate a device control window for the selected gate by right clicking on the icon.  The right click on the icons shall display a pop-up menu of available device actions from which the user may select.  This action shall cause a circle to be displayed over the gate icon for as long as the device control window is displayed for that gate.

3.2.1.1.9.1 If operation of the device is locked out for safety reasons a command option will be “grayed out” and not selectable.

3.2.1.2 Popups

3.2.1.2.1 An icon shall be selected during detailed design to indicate a group of popups in an “Up” or entrance closed position.

3.2.1.2.2 An icon shall be selected during detailed design to indicate a group of popups in a “Down” or entrance opened position.

3.2.1.2.3 An icon shall be selected during detailed design to indicate a failure status when some popups in a group are in a “Down” position and some popups in the same group are in an “Up’ position.

3.2.1.2.4 The popup icon shall be configurable to display the name of the popup group.

3.2.1.2.5 The popup icon shall be configurable to display the state of the popup group (up or down).

3.2.1.2.6 The popup icon shall be configurable to display the status of the popup group.  The color of the icon shall be changed to show the status of the popup group.

3.2.1.2.7 When the operator moves the mouse over a popup icon a text window shall be displayed showing a summary of the popup group status.  The details of the status display will be defined in the GUI design document.

3.2.1.2.8 The operator shall be able to activate a detailed device status window for the selected popup group by double left clicking on the icon.  A circle shall be displayed over the icon as long as the detailed status window is displayed for the icon.

3.2.1.2.9 The operator shall be able to activate a device control window for the selected popup by right clicking on the icon.  The right click on the icon shall display a pop-up menu of available device actions from which the user may select.  A circle shall be displayed over the icon as long as the device control window is displayed for the icon.

3.2.1.2.9.1 If operation of the device is locked out for safety reasons a command option will be “grayed out” and not selectable.

3.2.1.3 CMS

3.2.1.3.1 An icon shall be selected during detailed design to indicate changeable message signs.

3.2.1.3.2 An icon shall be selected during detailed design to indicate a changeable message sign that is displaying a message.

3.2.1.3.3 The CMS icon shall be configurable to display the name of the sign with the icon.

3.2.1.3.4 The CMS icon shall be configurable to display an abbreviated message text with the icon.

3.2.1.3.5 The CMS icon shall be configurable to display the status of the sign associated with the icon. The CMS icon color shall represent the operational status of the CMS sign: green for operational, yellow for operational with errors, gray for no communications and red for failed.

3.2.1.3.6 If the operator moves the mouse over the CMS icon then a text window shall be displayed with a summary of the operational state and status of the sign and the text of any message being displayed on the sign.

3.2.1.3.7 The operator shall be able to activate a detailed device status window for the sign by double left clicking on the selected icon.  A circle shall be displayed over the icon as long as the detailed device status window is displayed for that icon.

3.2.1.3.8 The operator shall be able to activate a device control window for the CMS sign by right clicking on the selected icon.  The right click on the icon shall display a pop-up menu of available device actions from which the user may select.  A circle shall be displayed over the icon as long as the device control window is displayed for that icon.

3.2.1.3.8.1 If operation of the device is locked out for safety reasons a command option will be “grayed out” and not selectable.

3.2.1.4 CCTV Camera

3.2.1.4.1 An icon shall be selected to indicate a CCTV camera

3.2.1.4.2 The camera icon shall be configurable to show the name of the camera with the icon.

3.2.1.4.3 The camera icon shall be configurable to show the state of the camera.

3.2.1.4.4 The camera icon shall be configurable to show the status of the camera.  The color of the camera icon shall be changed to show the status of the camera.

3.2.1.4.5 When a user moves the mouse over a camera icon a text window shall be displayed showing a summary of the camera status.

3.2.1.4.6 The user shall be able to activate a detailed device status window for the selected camera by double left clicking on the icon.  This action shall cause a circle to be displayed over the camera icon for as long as the detailed device status window is displayed for that camera.

3.2.1.4.7 The user shall be able to activate a device control window for the selected camera by right clicking on the icon.  The right click on the icon shall display a pop-up menu of available device actions from which the user may select.  This action shall cause a circle to be displayed over the camera icon for as long as the device control window is displayed for that camera.

3.2.1.5 Draw Lights

3.2.1.5.1 An icon shall be selected during detailed design to indicate a group of draw lights that are off.

3.2.1.5.2 An icon shall be selected during detailed design to indicate a group of draw lights that are on.

3.2.1.5.3 An icon shall be selected during detailed design to indicate a group of draw lights where some are on and some are off.

3.2.1.5.4 The draw light icon shall be configurable to display the name of the draw lights.

3.2.1.5.5 The draw light icon shall be configurable to display the state of the draw lights.

3.2.1.5.6 The draw light icon shall be configurable to display the status of the draw lights.  The color of the draw light icon shall represent the status of the draw light: green for operational, yellow for operational with errors, gray for no communications and red for failed.

3.2.1.5.7 When the operator moves the mouse over a draw light icon a text window shall be displayed showing a summary of the status of the group of draw lights.  The details of the status display will be defined in the GUI design document.

3.2.1.5.8 The operator shall be able to activate a detailed device status window for the draw lights by double left clicking on the selected icon.  A circle shall be displayed over the icon as long as the detailed device status window is displayed for that icon.

3.2.1.5.9 The operator shall be able to activate a device control window for the draw lights by right clicking on the selected icon.  The right click on the icon shall display a pop-up menu of available device actions from which the user may select.  A circle shall be displayed over the icon as long as the device control window is displayed for that icon.

3.2.1.5.9.1 If operation of the device is locked out for safety reasons the command option will be “grayed out” and not selectable.

3.2.1.6 Wrong Way Lights

3.2.1.6.1 An icon shall be selected during detailed design to indicate a group of wrong way lights that are off.

3.2.1.6.2 An icon shall be selected during detailed design to indicate a group of wrong way lights that are on.

3.2.1.6.3 An icon shall be selected during detailed design to indicate a group of wrong way lights where some are on and some are off.

3.2.1.6.4 The wrong way light icon shall be configurable to display the name of the draw lights.

3.2.1.6.5 The wrong way light icon shall be configurable to display the state of the wrong way lights.

3.2.1.6.6 The wrong way light icon shall be configurable to display the status of the group of wrong way lights.  The color of the wrong way light icon shall represent the status of the wrong way light: green for operational, yellow for operational with errors, gray for no communications and red for failed.

3.2.1.6.7 When the operator moves the mouse over a wrong way light icon a text window shall be displayed showing a summary of the status of the group of wrong way lights.  The details of the status display will be defined in the GUI design document.

3.2.1.6.8 The operator shall be able to activate a detailed device status window for the wrong way lights by double left clicking on the selected icon.  A circle shall be displayed over the icon as long as the detailed device status window is displayed for that icon.

3.2.1.6.9 The operator shall be able to activate the control window for the wrong way light by right clicking on the selected icon.  The right click on the icon shall display a pop-up menu of available device actions from which the user may select.  A circle shall be displayed over the icon as long as the device control window is displayed for that icon.

3.2.1.6.9.1 If operation of the device is locked out for safety a command option will be “grayed out” and not selectable.

3.2.1.7 Loop Detectors

3.2.1.7.1 An icon shall be selected during detailed design to indicate a loop detector.

3.2.1.7.2 An icon shall be selected during detailed design to indicate a group of loop detectors.

3.2.1.7.3 The loop detector and group detector icons shall use color to indicate either speed, volume, or occupancy is within a specified range or if no data is available from the detector or from all loop detectors in a group.

3.2.1.7.4 The color used to indicate a range shall be configurable.

3.2.1.7.5 The data being displayed by color shall be configurable.

3.2.1.7.6 The range being displayed by a color shall be configurable.

3.2.1.7.7 The operator shall be able to configure the color, the range and/or the data type without restarting the application.

3.2.1.7.8 The loop detector icon shall be configurable to display the name of the loop detector.

3.2.1.7.9 The loop detector icon shall be configurable to display the N second volume, speed and occupancy values as text associated with the icon.  The value on N shall be configurable.

3.2.1.7.10 The group detector icon shall be configurable to display the name of the detector group name as text with the icon.

3.2.1.7.11 The group detector icon shall be configurable to display the N second average of volume, speed and occupancy for all detectors in the group as text with the icon.  The value of N shall be configurable.

3.2.1.7.12 The detector loop icon shall be configurable to display the status of the loop detector or group of loop detectors.

3.2.1.7.13 When the operator moves the mouse over a detector loop icon a text window shall be displayed showing a summary of the status of the loop detector or the group of detector loops.  The details of the status display will be defined in the GUI design document.

3.2.1.7.14 The operator shall be able to activate a detailed device status window for the loop or group of loops by double left clicking on the selected icon.  A circle shall be displayed over the icon as long as the detailed device status window for that icon.

3.2.1.8 FCU and DCU/MCU

3.2.1.8.1 Icons shall be selected during detailed design to represent the FCUs and the DCU/MCUs.

3.2.1.8.2 The FCU icon and the DCU/MCU icon shall be configurable to show the name of the site with the icon.

3.2.1.8.3 The icons shall be configurable to show the status of the equipment at the site.  The color of the icons shall be changed to show the status of the equipment.

3.2.1.8.4 When the operator moves the mouse over an FCU or DCU/MCU icon a text window shall be displayed showing a summary of the site status.  The details of the status display will be defined in the GUI design document.

3.2.1.8.5 The operator shall be able to activate a detailed device status window for the selected site by double left clicking on the icon.  This action shall cause a circle to be displayed over the icon for as long as the detailed device status window is displayed for that site.

3.2.1.9 HOV End Points

3.2.1.9.1 An icon shall represent the end point of the HOV lanes (North and South).  The icon shall have different shapes to represent that the end point is closed, open Southbound or open Northbound.

3.2.1.9.2 The end point icon shall be configurable to show the name of the end point associated with the icon.

3.2.1.9.3 The end point icon shall be configurable to show the state of the end point associated with the icon.

3.2.1.9.4 The end point icon shall be configurable to show the status of the end point.  The color of the icon shall be changed to show the status of the end point.

3.2.1.9.5 When the operator moves the mouse over an end point icon a text window shall be displayed showing a summary of the end point status.  The details of the summary status display will be defined in the GUI design document.

3.2.1.9.6 The operator shall be able to activate a detailed device status window for the selected end point by double left clicking on the icon.  This action shall cause a circle to be displayed over the icon for as long as the detailed device status window is displayed for that end point.

3.2.1.10 Incidents

3.2.1.10.1 An icon shall be selected during detailed design to represent active incidents.

3.2.1.10.2 The incident icon shall be configurable to display the state of the incident.

3.2.1.10.3 When the operator moves the mouse over an incident icon a text window shall be displayed showing a summary of the incident state.  The details of the summary state display will be defined in the GUI design document.

3.2.1.10.4 The operator shall be able to activate a detailed incident state window for the selected incident by double left clicking on the icon.  This action shall cause a circle to be displayed over the incident icon for as long as the detailed device status window is displayed for that incident.

3.2.1.10.5 The operator shall be able to activate an edit window for the selected incident by right clicking on the icon.  This action shall cause a circle to be displayed over the incident icon for as long as the edit window is displayed for that incident.

3.3 Windows

Information on the screen of the user’s monitor shall be presented in a window.  Various windows shall display maps information, menus, text and graphic information and forms.  Windows shall be adjustable in size and location, but shall have a default size and location.

3.3.1 Map Window

3.3.1.1 The map window shall display the HOV lanes, the adjacent lanes of I-15 and SR 163, crossing streets and their interchange, if any, and icons.

3.3.1.2 Three map windows shall be provided: one showing the entire length of the HOV lanes, one showing a detail of the south end of the HOV lanes and one showing a detail of the North end of the HOV lanes.

3.3.1.3 Caltrans shall be able to create new maps using a commercial off the shelf (COTS) software package and place device icons on the map.

3.3.2 Command Toolbar

3.3.2.1 The Command Toolbar shall allow a user to select a window for display.

3.3.2.2 The Command Toolbar shall always be displayed to the user.

3.3.2.3 The Command Toolbar shall only display valid commands.

3.3.3 Device Control Window

3.3.3.1 Menu

3.3.3.1.1 The device control window shall display a three level menu allowing the operator to select the device to be commanded.

3.3.3.1.1.1 The first level shall be the device type selection: CMS, draw light, gate, pop-up, etc.

3.3.3.1.1.2 The second level shall be a list of specific devices of that type that are available to be commanded.

3.3.3.1.1.3 The third level shall be a list of available commands (if any) for the selected device.

3.3.3.1.2 Once the device type, device and command have been selected via the menu system the operator shall be presented with a form for the completion of any parameters for the command.

3.3.3.1.3 The device command completion form shall have a button labeled “Perform Action” to allow the operator to execute the command.

3.3.3.1.3.1 The “Perform Action” button shall be grayed out and unselectable until the device command form has been filled out.

3.3.3.1.3.2 The “Perform Action” button shall log the command submittal.

3.3.3.1.4 The device command completion form shall have a button labeled “Cancel Command” to allow the operator to stop the completion of the command.

3.3.3.2 Confirmation Dialog

3.3.3.2.1 Any device control action that involves human safety shall use a confirmation dialog to validate the action.

3.3.3.2.1.1 All device actions defined in the detailed design shall be classified as either involving human safety or not involving human safety.

3.3.3.2.1.2 The default classification shall be that the device action involves human safety.

3.3.3.2.2 The required validation method (if any) shall be displayed with the confirmation dialog.

3.3.3.2.3 The confirmation dialog shall specify the action and prompt the user for a YES or NO to continue.

3.3.3.2.4 The confirmation dialog shall default to NO.

3.3.3.3 The action and the confirmation shall be displayed in the System Log window.

3.3.3.4 The device control window shall display any returned device status resulting from the device control command.

3.3.3.5 If the requested device control command results in multiple steps at the field control level, the intermediate steps and their status shall be displayed in the device control window.

3.3.4 Summary Device Status Window

3.3.4.1 The summary device status window shall display a text and graphic summary presentation on the status of the selected device or group of devices.

3.3.5 Detailed Device Status Window

3.3.5.1 The detailed device status window shall display a text and graphic presentation on the status of the selected device or group of devices.

3.3.5.2 The detailed device status window shall allow a user to select more detailed status information on an individual device.

3.3.5.3 The operator shall be able to call up a device control window for any device shown on the device status window.

3.3.5.4 The summary device status window shall have a menu bar with File and Help as a minimum.

3.3.5.4.1 The File menu item shall include an option to open a command window for the selected device.

3.3.5.4.2 The File menu item shall include an option to open a detailed status window for the selected device.

3.3.5.4.3 The File menu item shall include an option to print the summary device status page.

3.3.5.4.4 The Help menu item shall activate the on-line help system.

3.3.5.5 The summary device status window shall display a list of all devices along with a miniature icon of the device color coded with the device status.  The color-coding shall match the color-coding described above.

3.3.5.6 The summary device status window shall list the full name of each device.

3.3.5.7 The summary device status window shall list the most reason error code and description for the device if the device is failed or experiencing errors.

3.3.5.8 The summary device status window shall list the time and date of the last device status check.

3.3.6 Incident Entry / Edit Window

This window shall enable the user to enter and edit an incident report to displayed as an icon on the map window.

3.3.6.1 A user shall be able to enter information on an incident, including, location, description and time period.

3.3.6.2 A user shall be able to edit or close an existing incident.

3.3.6.3 Entry or editing of an incident shall be recorded in the Daily Diary along with the time and the user performing the entry.

3.3.6.4 The Incident Entry / Edit Window shall have a menu bar with File, Edit, Report, and Help.

3.3.6.4.1 The File menu item shall have an option to create a new incident entry.

3.3.6.4.2 The File menu item shall have an option to print the Incident Entry / Edit Window.

3.3.6.4.3 The Edit menu item shall have an option to append information to an incident entry.

3.3.6.4.4 The Edit menu item shall have an option to update the information on an incident entry.

3.3.6.4.5 The report menu shall have an option to print a report on all active incidents.

3.3.6.4.6 The report menu shall have an option to print a report on all entries associated with a specific incident.

3.3.6.4.7 The Help menu item shall invoke the Help system.

3.3.7 Daily Diary Window

3.3.7.1 Operator command and confirmation actions shall be recorded in the Daily diary

3.3.7.2 The Daily Diary Window shall show the date and time of the entry.

3.3.7.3 The Daily Diary Window shall show the ID of the operator for each entry.

3.3.7.4 The Daily Diary Window shall provide a button (labeled Diary Entry) to activate a screen (Diary Entry) for the operator to make a Diary entry.

3.3.7.5 The Diary Entry screen shall provide the operator with a form to make an entry in the Daily Diary.

3.3.7.6 The current date, time and operator ID shall be displayed on the form in read-only display fields.

3.3.8 Problem Work Order Window

3.3.8.1 The Problem Work Order Window shall allow the User to enter, modify and close information about a system failure.

3.3.8.1.1 The Problem Work Order Window shall have a menu bar with File, Edit, Report and Help.

3.3.8.1.1.1 The File menu item shall have an option to create a new system failure entry.

3.3.8.1.1.2 The File menu item shall have an option to print the Problem Work Order Window.

3.3.8.1.1.3 The File menu item shall have an option to close the Problem Work Order Window.

3.3.8.1.1.4 The Edit menu item shall have an option to add an update to an existing system failure.

3.3.8.1.1.5 The Report menu item shall include an option to print all entries associated with a specific device.

3.3.8.1.1.6 The Report menu item shall include an option to print a summary of all active system failures.

3.3.8.1.1.7 The Report menu item shall include an option to print all entries associated with a specific system failure.

3.3.9 Scheduler Window

3.3.9.1 The Scheduler Window shall allow the user to enter, modify, delete and view information on events that affect the facility.

3.3.9.2 The user shall be able to search for specific events by date and type.

3.3.10 Paging Contact Window

3.3.10.1 The Paging Contact Window shall allow an authorized user to enter, modify and delete a paging profile for various points of contact.

3.3.11 Macro Editor Window

The Macro Editor will provide the operators with the ability to create and modify macros and super-macros.  A macro (or super macro) is a sequence of device actions that are preconfigured by the user.  The user can activate the sequence of actions by invoking a single command.  A basic assumption for the execution of macros and super macros is that the operator will be required to validate that an action has successfully completed before the next action is started.

The user interface with the macro editor is to be based on the outline editing capabilities of Microsoft Word 97.

3.3.11.1 The user shall select an existing macro to be edited or to define a new macro.

3.3.11.2 The operation being implemented shall determine which operations are permissible.

3.3.11.3 The Macro editor shall allow the user to insert a device action into a macro.

3.3.11.4 The Macro editor shall allow the user to delete a device action from a macro.

3.3.11.5 The operator shall be able to modify the order of the actions by selecting an action with the mouse and dragging the action to a new location in the macro.

3.3.11.6 The Macro editor shall allow the user to specify a security level on a macro.

3.3.11.7 The Macro editor shall allow the user to specify a minimum delay time between device actions.

3.3.11.8 The Macro editor shall allow the user to specify that operator confirmation is required prior to starting a device action.

3.3.11.9 The Macro editor shall allow the user to specify a valid time of activation for the macro.

3.3.11.10 The Macro editor shall allow the user to specify the expected amount of time an action will take to complete.

3.3.12 Macro Control Window

3.3.12.1 The Macro Control Window shall provide a File entry on the menu bar.

3.3.12.2 The Macro Control Window shall provide an Open entry under the File entry on the menu bar.

3.3.12.3 The Macro Control Window shall provide a button (labeled Start) to start the macro.

3.3.12.4 The Macro Control Window shall provide a button (labeled Pause) to pause the macro execution.

3.3.12.5 The Macro Control Window shall provide a button (labeled Stop) to halt execution of the macro execution.

3.3.12.6 The Macro Control Window shall provide a button (labeled Next) to execute the next action in the sequence.

3.3.12.7 The Macro Control Window shall provide a counter showing the elapsed time since the macro execution was started.

3.3.13 Logon Window

3.3.13.1 The Logon window shall enable a user to enter a user name and password.

3.3.13.2 The Logon Window will indicate to the user if the user name and password were accepted.

3.3.13.3 The Logon window shall allow the user to accept or reject command authority for the system.

3.3.14 User Identification Window

3.3.14.1 The User Identification Window shall display the name of the user logged at this workstation, the location of the workstation, the name and location of the user with command control (the operator) and the date and time.

3.3.14.2 The User Identification Window shall always be displayed.

3.3.15 User Administration Window

3.3.15.1 The User Administration Window shall allow a properly authorized operator to enter/modify/delete user names, passwords, user security level and use display preferences.

3.3.16 Report Windows

3.3.16.1 The Report Windows shall allow the user to select and view reports generated by the system.

3.3.16.2 The Report Window shall allow the user to select the information to be included in a report format, including the time frame the report is to cover.

3.3.17 Scenario Editor Window

Training users will use the Scenario Editor to create training scripts for the simulator.  These training scripts can be used to train new operators in basic I-15 reversible lane operation.  The training scripts can also be used to train all staff in how to handle unusual situations.

3.3.17.1 The Scenario Editor shall provide the operator with the ability to create new scenarios.

3.3.17.2 The Scenario Editor shall provide the operator with the ability to modify existing scenarios.

3.3.17.3 The Scenario Editor shall provide the operator with the ability to define the state of all devices: operational, failed, unknown.

3.3.17.4 The Scenario Editor shall provide the operator with the ability to define equipment malfunctions by an offset time from the start of the scenario.

3.3.18 Scenario Control Window

The Scenario Control Window shall allow the training user to control the execution of a scenario.  The Scenario Control Window must be versatile in allowing the training user to start the scenario and then to control the scenario as the scenario progresses.

3.3.18.1 The Scenario Control Window shall provide the training user the ability to start a scenario.

3.3.18.2 The Scenario Control Window shall provide the training user the ability to pause a scenario.

3.3.18.3 The Scenario Control Window shall provide the training user the ability to restart a scenario.

3.3.18.4 The Scenario Control Window shall provide the training user the ability to correct device malfunctions.

3.3.18.5 The Scenario Control Window shall provide the training user the ability to create device malfunctions.

3.3.18.6 The Scenario Control Window shall provide the training user the ability to see all commands issued by the trainee user.

3.3.19 Help Window

3.3.19.1 The Help Window shall allow the user to request and display help information.

3.4 Performance Requirements

The system performance requirements are specified in Paragraph 3.2.5 of the System Requirements Document.

4. Graphical User Interface Guidelines

4.1 General Guidelines

4.1.1 Icons

This section specifies that a set of icons will be defined and used by the development team.

4.1.1.1 All icons shall be configurable to display a minimum of information as text with the icon.

4.1.1.1.1 The icons shall be configurable to display the text with relationship to the icon at the top, bottom, left or right.

4.1.1.2 All icons shall be configurable to display four colors: green, yellow, red, or gray

4.1.1.2.1 For all icons the color gray shall represent no data available, that is, communication with the device is not possible.

4.1.1.2.2 For all icons except the Loop Detector icon, the other colors shall represent the status of the device, with the color green indicating a working device, red indicating a failed device, and yellow indicating a partially failed device.

4.1.1.2.3 For the Loop Detector Icon, the meaning of the color of the icon is defined in 5.2.1.7.

4.1.2 Form Entry

The following requirements shall be followed for all screens that use defined forms to help the user enter data for the system.

4.1.2.1 The form shall open with the cursor in the top left entry field.

4.1.2.2 The TAB key shall move the cursor in a Z pattern from left to right and top to bottom through the fields of the form.

4.1.2.3 All form screens shall have a button on the screen to clear all user entry from the fields of the form.  This button shall be labeled “CLEAR”.

4.1.2.4 All form screens shall have a button on the screen to save the data entered into the fields of the form.  This button shall be labeled “SAVE”.

4.1.2.5 All form screens shall have a button on the screen to exit the form entry process.  This button shall be labeled “EXIT”.

4.1.3 Field Validation

4.1.3.1 If a user entry must be one of several defined items, then the system shall present the user with the list of items from which to select the entry.

4.1.3.1.1 The form window shall be sized to display a minimum of 5 items from the selection list.

4.1.4 Error Message Window

4.1.4.1 Error messages shall be displayed in a scrollable window.

4.1.4.2 The user shall be able to select the fields available for display in the error window.

4.1.4.3 The user shall be able to select the field for sorting the display in the error window.

4.1.4.4 The user shall be able to select the sort order for the display in the error window.

4.1.5 Fonts

4.1.5.1 A maximum of 3 fonts shall be used in the user interface.  These fonts shall be defined in the interface design.

4.1.5.2 A maximum of 4 font sizes shall be used in the user interface.

4.1.6 Combination Boxes

4.1.6.1 A window combination box shall display a minimum of 4 items and a maximum of 9 items when it is expanded.

4.1.7 Hot Keys

4.1.7.1 The Ctrl-O key combination shall execute the Open command in any window where Open is a valid action.

4.1.7.2 The Ctrl-S key combination shall execute the Save command in any window where Save is a valid action.

4.1.7.3 The Ctrl-P key combination shall execute the Print command in any window where Print is a valid action.

4.1.7.4 The F1 key shall invoke the Help system.

4.1.8 User Login

4.1.8.1 User login shall be controlled by the operating system.

4.1.9 Window Configuration

4.1.9.1 When a user logs off of the system, the configuration of open windows shall be saved

4.1.9.2 When a user logs on to the system, the last saved configuration of open windows for that user shall be displayed.
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